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INTRODUCTION:  
INTRO AND HISTORY TO  
THE ECLIPSE IDE

This report focuses on the most commonly used 
Java IDE currently available to mankind. Under 
the spotlight is Eclipse, the most widely selected, 
praised and complained about IDE. 
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Intro and history to the Eclipse IDE

The Eclipse IDE, according to a recent report on developer productivity, 
is used by roughly two-thirds of the 1800+ Java developers we talked to, 
PDNLQJ�LW�D�VLJQLȴFDQW�SOD\HU�LQ�WKH�Ζ'(�PDUNHW��:LWK�WKH�ODUJHVW�XVHU�EDVH�
and a vast number of plugins and integrations into the development world, 
(FOLSVH�LV�ZKHUH�PRVW�GHYHORSHUV�VWDUW�R΍�ZKHQ�LW�FRPHV�WR�ZULWLQJ�FRGH�

(FOLSVH�LV�D�VHOI�GHVFULEHG�XQLYHUVDO�WRROVHW�IRU�GHYHORSPHQW��GHȴQHG�DV�D�
platform for building integrated development environments and tools for 
YDULRXV�ODQJXDJHV��+RZHYHU�WKDW�LV�D�YHU\�EURDG�GHVFULSWLRQ�DQG�VRPHWLPHV�
it's nice to see the actual trees in the forest, so here's our take on it: Eclipse is 

an extremely customizable Java IDE which supports several other languages and 

development platforms.

(FOLSVH�VWDUWHG�R΍�DV�DQ�Ζ%0�&DQDGD�SURMHFW�EDFN�LQ�������ODWHU�UROOHG�LQWR�
an open-source program with a consortium of stewards from leading 
FRPSDQLHV��6LQFH�������LW�LV�VXSSRUWHG�DQG�PDLQWDLQHG�E\�WKH�(FOLSVH�
)RXQGDWLRQ��ZKLFK�LV�D�QRQ�SURȴW�RUJDQLVDWLRQ�WKDW�LV�EDFNHG��L�H��IXQGHG�
by annual dues) by top industry companies, like Oracle, IBM, Red Hat, SAP, 
Google and ZeroTurnaround ;-)

The Eclipse Foundation not only keeps the infrastructure of the Eclipse IDE 
SURMHFW�UXQQLQJ�DQG�KHOSV�VHW�XS�WUDQVSDUHQW�	�PDLQWDLQDEOH�GHYHORSPHQW�
IRU�SURMHFWV�WKDW�DUH�ZLOOLQJ�WR�MRLQ�WKH�XPEUHOOD�RI�(FOLSVH��EXW�WKH\�DOVR�
SULRULWL]H�WKH�FDUH�RI�WKH�(FOLSVH�HFRV\VWHP�DQG�FRPPXQLW\��7KH�(FOLSVH�
)RXQGDWLRQ�DFWLYHO\�PDUNHWV�DOO�NLQGV�RI�SURMHFWV�EDVHG�RQ�RU�XVLQJ�(FOLSVH�
which, combined with the availability of educational materials, makes Eclipse 
D�VROLG�FKRLFH�ZKHQ�LW�FRPHV�WR�GHWHUPLQLQJ�\RXU�QH[W�SURMHFW
V�SODWIRUP�
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PART I:
GETTING STARTED WITH 
INSTALLATION AND MAINTENANCE

5HDG�WKH�PDQXDO��7KH�ȴUVW�TXHVWLRQ�DERXW�DQ\�SDUWLFXODU�
kind of software in such a large and vague category as 
IDEs is about what it does that others don't. We will talk 
about that a bit later, but for now, let us be coherent 
and start with a more down-to-earth approach, like how 
Eclipse is distributed, what bundles to download and in 
general how to get started. 
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Eclipse bundles: Java EE, Java, C/C++ and more

Eclipse provides a platform to create powerful applications and has a huge 
ecosystem of plugins; therefore, it’s easy for them to create archives that 
JHQHULFDOO\�ȴW�VRPH�SUREOHP�VSDFH�YHU\�ZHOO��6R�WKH�HDVLHVW�DQG�PRVW�
straightforward way to get started with Eclipse is to download a so-called 
'packaged solution', which is basically a bundled archive that includes, 
�LV�DQ�DUFKLYH�WKDW�LQFOXGHV�DQ�(FOLSVH�5XQWLPH�ZLWK�SUHLQVWDOOHG�WRROV��$V�
we can see, the Eclipse bundle for Java EE developers is the most frequently 
GRZQORDGHG�
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If you go after Eclipse for Java Developers, you’ll get some more things, 
OLNH�0DYHQ�EXLOG�WRRO�LQWHJUDWLRQ�DQG�;0/�HGLWRU�VXSSRUW��$�EXQGOH�IRU�
Java EE developers adds around 100MB of additional features, and this 
LQVWDOODWLRQ�ZLOO�EH�DZDUH�RI�ZHE�DSSOLFDWLRQ�DUFKLWHFWXUHV�DQG�-3$��-6)��HWF��
It even comes with Mylyn support, which allows you to connect your Eclipse 
installation to task-tracking solutions like Jira, Github Issue Tracker, Bugzilla  
and more so you can resolve issues and work on other tasks without leaving 
WKH�VDPH�ZRUNLQJ�ZLQGRZ��

There is also a mobile dev platform called Android Developer Tools��RU�$'7��
It can be installed to your existing Eclipse installation as a plugin, but it is 
UDUHO\�XVHIXO�WR�KDYH�UHJXODU�ROG�-DYD��SURMHFWV�PL[HG�WRJHWKHU�ZLWK�$QGURLG�
VWX΍��VR�WKH�$'7�EXQGOH�LV�PRUH�FRQYHQLHQW��

ADT is a powerful bundle, and it includes tools to test and debug Android 
apps both in a simulator and on devices, plus it contains UI builders and 
VXSSRUWV�QDWLYH�GHYHORSPHQW�WRR�

http://developer.android.com/tools/index.html
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Platform runtime binaries DQG�D�TXLFN�VLGHQRWH�RQ�26*L
3ODWIRUP�UXQWLPH�ELQDULHV�DUH�DQRWKHU�ZD\�WR�JHW�DURXQG�(FOLSVH��ΖI�\RX�GRQ
W�
want a pre-packaged solution and think that Eclipse maintainers will likely 
VWX΍�LW�ZLWK�WKLQJV�WKDW�\RX�GRQ
W�XVH�DQ\ZD\��\RX�FDQ�JHW�WKH�EDUH�ERQHV�
ELQDU\��ZKLFK�LV�MXVW�WKH�SODWIRUP�WR�ZKLFK�\RX�FDQ�DGG�\RXU�RZQ�WRSSLQJV�
DV�\RX�OLNH��7KH�3ODWIRUP�%LQDU\�DUFKLYH�LV�MXVW�DERXW����PHJDE\WHV�DQG�LWȇV�
SUHWW\�GDUQ�IDVW�EHFDXVH�LW�FRPHV�VWULSSHG�RI�DQ\WKLQJ�WKDW�FDQ�VORZ�LW�GRZQ��

Since we all like to be fast in development, let's try simple and not-at-all 
VFLHQWLȴF�H[SHULPHQW��PHDVXULQJ�VWDUW�XS�WLPHV�RI�(FOLSVH�5XQWLPH�ELQDU\�YV�
D�PDFKLQH�ZLWK�:LQGRZV����-'.��X����(FOLSVH�-((��:H�WLPHG�WKLV�RQ�DQ�L3KRQH�
VWRSZDWFK�ZLWK�D�VWHDG\�KDQG��VR�GRQ
W�MXGJH�XV�WRR�KDUVKO\����

$V�\RX�FDQ�VHH��WKHUH�LV�D�GL΍HUHQFH�LQ�VWDUWXS�VSHHG��KRZHYHU�ZH�DUH�QRW�
VXUH�LI�LW
V�VLJQLȴFDQW��$OVR�QRWH�WKDW�WKH�ZRUNVSDFH�ZDV�HPSW\��EXW�PRUH�
RIWHQ�WKDQ�QRW�\RXȇOO�KDYH�VHYHUDO�RSHQ�HGLWRUV�DQG�ȴOHV�WR�LQGH[��VR�WKH�
GL΍HUHQFH�FRXOG�EH�PRUH�UHFRJQL]DEOH��

Eclipse Cold Start Warmed up

Until 
workspace 
VHOHFW��V�

Until it is  
UHDG\��V�

Until 
workspace 
VHOHFW��V�

Until it is  
UHDG\��V�

Eclipse JEE �� ���� ����������� ��������������

Platform 
binary

��� ���� �������������
������������

����



7All rights reserved. 2013 © ZeroTurnaround OÜ

ΖI�\RX�GHFLGH�WR�JLYH�3ODWIRUP�%LQDU\�D�WU\��MXVW�JR�WR�Help -> Install New 
Software..., pick the release/update site for your version of Eclipse and you'll 
get a list of things that you can add to your Eclipse installation:  programming 
languages packs, web development tools, modeling tools, all kinds of 
FRQQHFWRUV�DQG�DGDSWRUV�WR�ZRUN�ZLWK�H[WHUQDO�DSSOLFDWLRQV�DQG�VR�IRUWK��

5HDO�TXLFN��D�QRWH�DERXW�26*L��26*L�LV�D�PRGXOH�V\VWHP�DQG�D�G\QDPLF�
UXQWLPH�ZKHUH�PRGXOHV��DOVR�FDOOHG�EXQGOHV��FDQ�FRPH�DQG�JR��EXW�\RXU�
code has to conform to the requirements of the module system — it is 
perhaps the only widely-used framework for the JVM that enforces real 
PRGXODULW\��

Increased modularity will be really useful when you have:
. a complex set of dependencies
. lots of reusable pieces
. FXVWRPL]DWLRQV�RI�\RXU�VRIWZDUH�LQ�GL΍HUHQW�FRQWH[WV
. a chaotic mess of a system that needs some order introduced into it
. the need to install and uninstall services or plugins into a running  
 system

Luckily, this is exactly a case for your Eclipse IDE, where most of the 
functionality deals with some kind of text editors, or structured text editors 
like we use for XML—or where most of the features can be treated as 
RSWLRQDO�DQG�FRPH�IURP�SOXJLQV��

26*L�KDV�D�G\QDPLF�UXQWLPH��ZKLFK�FUHDWHV�D�GL΍HUHQW�FODVVORDGHU�IRU�
HYHU\�EXQGOH��7KHVH�FODVVORDGHUV�DUH�LVRODWHG�DQG�KDYH�UHIHUHQFHV�WR�RWKHU�
EXQGOH�FODVVORDGHUV��VR�LPSRUWLQJ�DQG�GHSHQGHQFLHV�PHFKDQLVPV�ZRUN��
However this approach allows OSGi to drop an entire module along with its 
FODVVORDGHU�DQG�UHFUHDWH�LW�DJDLQ�DW�D�ZKLP��7KLV�PDNHV�SRVVLEOH�OLPLWHG�FRGH�
UHORDGLQJ�SUDFWLFHV�DQG�JUHDWO\�EHQHȴWV�WKH�XSJUDGHDELOLW\�RI�WKH�DSSOLFDWLRQ�
HPSOR\LQJ�26*L��



8All rights reserved. 2013 © ZeroTurnaround OÜ

Other Eclipse-based IDEs

Needless to say that with a starting point as good as the Eclipse platform, 
DQ\�DGGLWLRQDO�H΍RUW�VKRXOG�OLNHO\�UHVXOW�IDLUO\�LPSUHVVLYHO\��0RVW�RI�WKH�Ζ'(V�
based on Eclipse are fully compliant with open standards from the Java 
development world, and fully charged to help developing an application 
ZLWK�(-%V��-3$��-6)��HWF��

Probably the best-known Eclipse-based IDE is Genuitec’s MyEclipse, which 
SRVLWLRQV�LWVHOI�DV�WKH�PRVW�FRPSUHKHQVLYH�-DYD�-DYH�((�Ζ'(�RQ�WKH�PDUNHW��
It is a commercial, proprietary solution that, in addition to the obvious 
toolsets we use to develop Java and web applications, also includes 
SUHFRQȴJXUHG�FRPSRQHQWV�WR�GHYHORS�+70/��DQG�PRELOH�DSSV��DQG�VHYHUDO�
DSSOLFDWLRQ�VHUYHUV�OLNH�7RP((��7KH�SDFNDJH�FRPHV�IXOO\�UHDG\�WR�EH�XWLOL]HG�
and you probably can save yourself some stress and time with MyEclipse’s 
TXLFN�LQVWDOODWLRQ�DQG�HDV\�FRQȴJXUDWLRQ�IRU�GR]HQV�RI�SOXJLQV��

 
 
 

 
Next up is IBM’s Rational Application Developer, or RAD, which focuses on 
easing the way of designing, developing and testing web applications utilizing 
WKH�IXOO�-DYH�((�VSHFWUXP�DQG�6HUYLFH�&RPSRQHQW�$UFKLWHFWXUH��ΖW�LQWHJUDWHV�
EHVW�ZLWK�Ζ%0�:HE6SKHUH�$SSOLFDWLRQ�6HUYHU�DQG�LQFOXGHV�SURȴOHUV��GDWD�
YLVXDOL]DWLRQ�WRROV�DQG�SURGXFWV�WR�ZRUN�ZLWK�WKH�Ζ%0�0LGGOHZDUH�OLQH�

Red Hat’s JBoss Developer Studio is another example of an IDE focused 
RQ�D�VSHFLȴF�VHW�RI�WHFKQRORJLHV�SURYLGHG�E\�D�ODUJH�FRPSDQ\�ZLWK�D�ZLGH�
DUUD\�RI�WRROV��+HUH�\RX
OO�VHH�LQWHJUDWLRQ�ZLWK�WKH�-%RVV�(QWHUSULVH�SODWIRUP��
DQG�RQ�WRS�RI�WKH�ODWHVW�(FOLSVH�DQG�:HE�7RROV�3URMHFW�LQFOXGHV�QXPEHU�RI�
H[FHOOHQW�IHDWXUHV�IURP�-%RVV�7RROV��
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How to migrate to new versions of Eclipse

Think it’s time to try the latest version of Eclipse? Here are a few notes about 
migrating, including compatibility issues and how to install via pointing to 
SUHYLRXV�ORFDWLRQV��

$V�ZH�ZULWH�WKLV�UHSRUW��WKH�ODWHVW�VWDEOH�YHUVLRQ�RI�(FOLSVH�LV�YHUVLRQ������
DND�Ȇ.HSOHUȇ��+RZHYHU�ZH
UH�VXUH�WKDW�D�ORW�RI�SHRSOH�DUH�VWLOO�XVLQJ�ROGHU�
EUDQFKHV��VXFK�DV�ΖQGLJR��Y�����RU�-XQR��Y������$V�D�GHYHORSHU��\RX�NQRZ�WKDW�
\RXU�Ζ'(�VHWWLQJV�DUH�D�YHU\�SHUVRQDO�WKLQJ��\RX�FDQ�FRQȴJXUH�LW�LQ�D�PLOOLRQ�
ways and once all the formatters, validators, plugins are properly set, it's 
UHDOO\�DQQR\LQJ�WR�UHFRQȴJXUH�D�QHZ�LQVWDQFH�RI�WKH�Ζ'(��

However, Eclipse includes a very cool feature that let’s you import everything 
IURP�DQRWKHU�LQVWDOODWLRQ��6R�ZKHQ�\RX�WKLQN�LW
V�WLPH�WR�WU\�D�QHZHU�YHUVLRQ�
RI�(FOLSVH��\RX�GRQ
W�QHHG�WR�ULVN�FRUUXSWLQJ�\RXU�FXUUHQW�LQVWDQFH��

-XVW�GRZQORDG�DQG�H[WUDFW�D�QHZ�DUFKLYH�VRPHZKHUH�DQG�VWDUW�LW��7KHQ�
simply go to File -> Import..���VHOHFW�From Existing Installation, feed it 
the path to your current Eclipse installation and voila! This will pick up your 
previous settings, create a list of installed plugins and go download them in a 
EDWFK��$IWHU�D�UHVWDUW��\RXU�QHZ�(FOLSVH�YHUVLRQ�ZLOO�IHHO�MXVW�OLNH�KRPH��

<RX�FDQ�PRYH�GLUHFWRULHV�ZLWK�(FOLSVHV�DURXQG�VR�DOO�\RXU�ȴOHV\VWHP�OLQNV�
DQG�VKRUWFXWV�ZLOO�SRLQW�WR�WKH�QHZ�RQH��7KHQ�\RX�FDQ�HQMR\�D�>KRSHIXOO\@�
more powerful, improved version of Eclipse and continue developing 
DZHVRPH�DSSV��

Now, if you are very eager to upgrade you can meet some compatibility 
LVVXHV��HVSHFLDOO\�ZLWK�SOXJLQV��7KH\�PLJKW�UHTXLUH�VRPH�ROGHU�YHUVLRQV�RI�D 
 

core component installed, which would resist installation because a newer 
YHUVLRQ�RI�LW�LV�DOUHDG\�DYDLODEOH��ΖQ�WKLV�FDVH�ZH�XVXDOO\�UHFRPPHQG�WKDW�\RX�
ZDLW�D�ELW��ΖI�D�VWDEOH�UHOHDVH�RI�(FOLSVH�LV�VFKHGXOHG�IRU�-XQH��WKHQ�\RX�FDQ�
DVVXPH�WKDW�DOO�UHODWHG�SURMHFWV�OLNH�SOXJLQV�DQG�RWKHU�WRROV�ZLOO�GR�WKHLU�EHVW�
WR�UHOHDVH�VRRQ�DIWHU�WKDW��7KHQ�XSJUDGLQJ�ZLOO�SUREDEO\�ZRUN�OLNH�D�FKDUP��
XQOHVV�\RX�XVH�VRPH�UDUH�SOXJLQ�

7KH�PDLQ�SRLQW�LV�WKDW�WKLV�LQVWDOODWLRQ�PHWKRG�FDQ�VDYH�\RX�VRPH�KHDGDFKHV�
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Tips for increasing performance

At this point, you should have yourself a running instance of Eclipse and can 
GLYH�LQWR�GHYHORSLQJ�\RXU�IDYRULWH�SURJUDPV��+RZHYHU��WKHUH�LV�RQH�WKLQJ�
WKDW�ZH�OLNH�WR�GR�ZKHQ�GHDOLQJ�ZLWK�IUHVK�(FOLSVH�LQVWDOODWLRQ��

That’s right: let’s make it faster!

Performance is a critical property of an IDE, and if it feels clumsy and slow 
it doesn’t matter how many awesome features it has, you're likely to look at 
D�GL΍HUHQW�Ζ'(�QH[W�WLPH��6R�KHUH�DUH�VRPH�KLQWV�DERXW�PDNLQJ�(FOLSVH�D�ELW�
PRUH�SURGXFWLYH��

3RLQW�QXPEHU����ΖI�\RX�GRQȇW�KDYH�LW�\HW��JHW�DQ�66'�GULYH��(FOLSVH�PDNHV�WRQV�
RI�ȴOH�RSHUDWLRQV��VR�IDVW�Ζ�2�LV�HVVHQWLDO��7KH�SHUIRUPDQFH�GL΍HUHQFH�FDQ�EH�
KXJH�DQG�LW�JURZV�ZLWK�WKH�QXPEHU�RI�SURMHFWV�\RX�KDYH�FXUUHQWO\�RSHQ��

First of all, Eclipse is a Java-based application, so all tuning advice that you 
NQRZ�DERXW�XVXDO�-DYD�SURJUDPV�DSSOLHV�KHUH�DV�ZHOO��8VH�WKH�ODWHVW�-'.�DQG�
SUHIHUDEO\�2UDFOH�2SHQ-'.��(FOLSVH�SHUIRUPV�EHVW�RQ�WKHP��7KHUH�DOVR�LV�DQ�
HFOLSVH�LQL�ȴOH�WKDW�VSHFLȴHV�RSWLRQV�IRU�-DYD�SURFHVVHV��$�W\SLFDO�LQL�ȴOH�ZLOO�
specify several arguments to the Java Virtual Machine, and below you’ll see 
DQ�H[DPSOH�RI�RXU�LQL�ȴOHV��

)LUVW��ZH�GRQȇW�ZDQW�WR�YHULI\�FODVV�ȴOHV��DQG�WKLV�PDNHV�VWDUWLQJ�XS�IDVWHU��
Also, let’s make use of G1 garbage collector and set some properties for the 
-Ζ7�FRPSLOHU��LW�LV�XVXDOO\�VPDUW�WR�VSHFLI\�PHPRU\�DUJXPHQWV�WRR��

-vmargs
-Xverify:none 
-XX:+UseG1GC

-XX:-DontCompileHugeMethods 
-XX:MaxInlineSize=1024  
-XX:FreqInlineSize=1024

-Xss1m
-XX:MaxPermSize=256m
-Xms512m
-Xmx512m

3OD\�ZLWK�WKRVH�SDUDPHWHUV�WR�VHH�KRZ�(FOLSVH�UHDFWV��ΖW�PLJKW�EH�D�JRRG�LGHD�
WR�LPSRUW�\RXU�SURMHFWV�ȴUVW��VR�\RX
OO�VHH�D�UHDO�ZRUOG�XVDJH�SHUIRUPDQFH�

1RZ�OHWȇV�WZHDN�LQ�(FOLSVH�SURSHUWLHV�WR�PDNH�OLIH�HYHQ�EHWWHU��8VXDOO\�WKHUH�
are several things that Eclipse does, but you don’t use every day or even not 
DW�DOO�DQG�FDQ�EH�GLVDEOHG�WR�JDLQ�VRPH�UHVSRQVLYHQHVV�LQ�UHWXUQ�
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In our humble opinion, Spellchecker, all kinds of validators and startup 
SOXJLQV�DUH�DPRQJ�WKH�ȴUVW�FDQGLGDWHV�WR�EH�GLVDEOHG��/XFNLO\��WKH�(FOLSVH�
preferences menu has good search functionality so you won’t need to 
WUDYHUVH�LW�DOO�WR�ȴQG�UHOHYDQW�ELWV��*R�WR�Preferences, type “spell” into 
VHDUFK�DQG�GLVDEOH�LW��

Continue with searching for “startup” and review the list of plugins 
XQGHU�Ȋ6WDUWXS�DQG�6KXWGRZQȋ��$UH�\RX�VXUH�WKDW�\RX�QHHG�WKDW�ȊP�H�
PDUNHWSODFHȋ"�'LVDEOH�LW��ΖI�\RX�DUH�QRW�VXUH��LWȇV�DOPRVW�DOZD\V�D�JRRG�
LGHD�WR�GLVDEOH�D�SOXJLQ��ΖI�\RX�UHDOL]H�ODWHU�WKDW�LW�ZDV�D�EDG�LGHD�DQG�
VRPHWKLQJ�GRHVQȇW�ZRUN��\RX�FDQ�DOZD\V�WXUQ�LW�EDFN�RQ�
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Another tip is to restrict the amount of editors that Eclipse will hold open while you’re playing with open or 
QHZ�ȴOHV��)LQG�WKH�Editors options in the Preferences�PHQX�DQG�VHW�LW�WR�VRPH�ORZHU�QXPEHU��5HPHPEHU��
HYHU\�RSHQHG�HGLWRU�FRQVXPHV�PHPRU\�DQG�WDNHV�SUHFLRXV�&38�F\FOHV�WR�SDUVH��YDOLGDWH��HWF��

Naturally, there are many more settings that can be changed to improve performance without compromising 
\RXU�XVHU�H[SHULHQFH��7KHVH�ȴUVW�IHZ�DUH�RXU�VLPSOH�VXJJHVWLRQV�WR�LPSURYH�WKH�UHVSRQVLYHQHVV�RI�\RXU�
(FOLSVH�LQVWDOODWLRQ�E\�D�QRWLFHDEOH�PDUJLQ��

5HPHPEHU��/LQXV�7RUYDOGV�WKLQNV�WKDW�SHUIRUPDQFH�DOPRVW�DOZD\V�PDWWHUV��:KDW�DERXW�\RX"�
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Other language packs for Eclipse – Scala, Python and Xtend

SCALA
Support for Scala programming with your Eclipse IDE is provided by Typesafe and other contributors, 
and it’s available from KWWS���VFDOD�LGH�RUJ���HLWKHU�DV�D�EXQGOH�RU�IURP�DQ�XSGDWH�VLWH���6XSSRUW�IRU�(FOLSVH�
��[�YHUVLRQV�LV�FXUUHQWO\�H[SHULPHQWDO��EXW�LWȇV�GHVLJQHG�WR�KRRN�LQWR�-DYD�'HYHORSPHQW�7RROV�YLD�UXQWLPH�
ZHDYLQJ�DQG�PDNHV�PL[HG�6FDOD�-DYD�SURMHFWV�ZRUN�UDWKHU�VHDPOHVVO\��8QIRUWXQDWHO\��LW�DOVR�PHDQV�WKDW�
LI�WKHUH�LV�D�EXJ�LQ�WKH�6FDOD�Ζ'(��WKH�EXJV�PD\�VXUIDFH�LQ�\RXU�-DYD�SURMHFWV�DV�ZHOO��ΖW�XVHG�WR�EH�TXLWH�
SUREOHPDWLF��EXW�KDV�EHHQ�UDWKHU�VWDEOH�VLQFH�YHUVLRQ������DW�WKH�WLPH�RI�WKLV�ZULWLQJ�LWȇV�Y�������

Besides the expected language pack features, such as perspective, editor with code completion, formatter, 
SURMHFW�QDWXUH��UHIDFWRULQJ�VXSSRUW�DQG�PRUH��WKHUH�DUH�VRPH�DZHVRPH�RSWLRQDO�IHDWXUHV��VXFK�DV�WKH�
ScalaTest plugin for running unit tests and Scala Worksheet, which combines a code editor and REPL into 
RQH��HYDOXDWLQJ�HDFK�OLQH�ZKHQ�\RX�VDYH�WKH�ȴOH�

http://scala-ide.org/
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PYTHON 
3URMHFWV�RIWHQ�UHTXLUH�VRPH�JOXH�VFULSWLQJ�DQG�LI�\RXȇUH�XVLQJ�3\WKRQ�IRU�WKDW�\RX�FDQ�EHQHȴW�IURP�KDYLQJ�D�
SURSHU�3\WKRQ�Ζ'(�LQVLGH�\RXU�(FOLSVH��PyDev, an open-source Eclipse plugin developed by Fabio Zadrozny, 
FDQ�KHOS�\RX�ZLWK�LW�

PyDev makes debugging Python scripts much easier, provides content assist for the interactive Python 
FRQVROH�DQG�LQ�JHQHUDO�KHOSV�\RX�ZRUN�ZLWK�3\WKRQ�FRGH�EHWWHU��2WKHU�IHDWXUHV�RI�3\'HY�LQFOXGH�
integrations with Django and unittest, including code-coverage support and the ability to quickly browse  a 
SURMHFWȇV�JOREDO�WRNHQV��

Refactoring isn’t as top-notch as a Java developer would hope for, but the most used things are there; like 
H[WUDFWLQJ��LQOLQLQJ�	�UHQDPLQJ�YDULDEOHV��DQG�H[WUDFW�PHWKRGV���1DWXUDOO\��\RX�FDQ�XVH�3\'HY�ZLWK�DQ\�ȵDYRU�
RI�3\WKRQ�\RX�ZDQW��QRUPDO��-\WKRQ�RU�ΖURQ3\WKRQ�

http://pydev.org/
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XTEND
Xtend�LV�D�ODQJXDJH�WKDW�JUHZ�RXW�RI�(FOLSVHȇV�H΍RUW�WR�EXLOG�D�IUDPHZRUN�IRU�ODQJXDJH�FUHDWLRQ��VR�LW�LV�
H[SHFWHG�WKDW�Ζ'(�VXSSRUW�LV�H[FHOOHQW��ΖQGHHG��\RX�FDQ�LQVWDOO�DQ�;WHQG�SOXJLQ�LQWR�\RXU�(FOLSVH�LQVWDOODWLRQ�
DQG�UXQ�D�IXOO�EXQGOH�ZLWK�;WHQG�VXSSRUW��7KH�IDFW�WKDW�WKH�Ζ'(�DQG�WKH�ODQJXDJH�LWVHOI�ZHUH�GHVLJQHG�
WRJHWKHU�PDNHV�D�GL΍HUHQFH��

;WHQG�FRPSLOHV�WR�-DYD�VRXUFH�FRGH�DQG�LV�FRPSOHWHO\�FRPSDWLEOH�ZLWK�-DYD�V\QWD[��VR�\RX�MXVW�QHHG�WR�DGG�
WKH�;WHQG�OLEUDU\�DV�D�GHSHQGHQF\�LQ�RUGHU�WR�XVH�;WHQG�LQ�D�XVXDO�-DYD�SURMHFW��7KH�SOXJLQ�PDNHV�LW�HDV\�
WR�FRQȴJXUH�WKH�ORFDWLRQ�ZKHUH�\RX�ZDQW�WR�JHQHUDWH�LQWHUPHGLDWH�-DYD�VRXUFH�ȴOHV�DQG�JR�WKURXJK�WKLV�
JHQHUDWHG�FRGH�ZKHQ�\RX�ZDQW�WR�VHH�ZKDW�;WHQG�GRHV�XQGHU�WKH�KRRG��

http://www.eclipse.org/xtend/
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PART II:  
MAKING ECLIPSE YOUR OWN

Now this is where Eclipse gets the most interesting. 
Plugins are an essential piece of the Eclipse 
ecosystem, and they are valuable to the user 
experience because they provide a great number 
of features to the default installation.
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Plugins and customizations

We must admit that it actually is a two-sided coin here; there's no easier way to make your Eclipse instance 
XQEHDUDEOH�WKDQ�WR�SROOXWH�LW�ZLWK�LQFRPSDWLEOH�RU�FRQȵLFWLQJ�SOXJLQV��7KH�FRQVHTXHQFHV�PD\�YDU\�IURP�DQ�
XQH[SHFWHG�FRORU�VFKHPH�RQ�VKHOO�VFULSW�HGLWRUV�WR�(FOLSVH�UHIXVLQJ�WR�VWDUW�EHFDXVH�\RXU�0HUFXULDO�SOXJLQ�EURNH��

However, given some experience, it's relatively easy to enhance your Eclipse installation and build up the things 
LW�FDQ�GR�IRU�\RX�

THE ECLIPSE MARKETPLACE 
It used to be that installing plugins into Eclipse happened by either unzipping an archive of plugins and features 
into the Eclipse folder, or by giving an update site URL to the included software installation wizard via Help -> 
Install New Software��7KH�XQ]LSSLQJ�PHWKRG�LV�SUHWW\�PXFK�JRQH��VR�QRZ�WKH�LQVWDOODWLRQ�LV�PRVWO\�GRQH�IURP�
XSGDWH�VLWHV�

But what if you don’t know any useful update sites? The Eclipse Foundation found that users also wanted a better 
way to discover plugins, so they created the Eclipse Marketplace��ZKLFK�DFWV�DV�D�NLQG�RI�D�SOXJLQ�UHJLVWU\��
<RXU�(FOLSVH�Ζ'(�DOVR�LQFOXGHV�D�0DUNHWSODFH�&OLHQW��Help -> Eclipse Marketplace), which can be used to search 
DQG�LQVWDOO�SOXJLQV�WKDW�DUH�UHJLVWHUHG�RQ�WKDW�VLWH��

Tip: You can also browse the marketplace website and drag “Install” links from the browser onto a menu 
RU�WRROEDU�DUHD�LQ�(FOLSVH�WR�LQLWLDWH�LQVWDOODWLRQ�XVLQJ�WKH�0DUNHWSODFH�&OLHQW�

http://marketplace.eclipse.org/
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SOME BASIC PLUGINS ANYONE CAN ENJOY 

EGit
7KHUH�DUH�D�QXPEHU�RI�SOXJLQV�WKDW�DUH�UHDOO\�HVVHQWLDO��HYHU\RQH�FDQ�EHQHȴW�
IURP�KDYLQJ�WKRVH�LQVWDOOHG��2QH�RI�WKRVH�LV�EGit�

This is an Eclipse Team Provider that is based on a Java implementation 
RI�*LW��(*LW�JLYHV�\RX�DELOLW\�WR�SHUIRUP�PRVW�*LW�FRPPDQGV�XVLQJ�D�7HDP�
PHQX�RI�D�SURMHFW�

ΖW
V�TXLWH�IDVW��XVHIXO��VWUDLJKWIRUZDUG�DQG�ZRUNV�ZHOO�ZLWK�*LW+XE��7KHUH�
is some advice to follow, but it mostly is well aligned with common sense: 
don't create Git repositories in your eclipse workspace and don't create a 
*LW�UHSR�ZLWK�\RXU�SURMHFW�DV�D�URRW�

If you're on the other side of the SCM camp and use Mercurial, don't worry, 
(FOLSVH�KDV�D�SOXJLQ�IRU�\RX�WRR���

MercurialEclipse
MercurialEclipse works quite the same as EGit, allowing you to synchronize, 
FRPPLW�DQG�SXVK�\RXU�FKDQJHV�WR�UHPRWH�ORFDWLRQV��ΖW�DOVR�JLYHV�\RX�DFFHVV�
to certain Mercurial extensions like mqueue, so you can do even more 
ZLWKRXW�OHDYLQJ�WKH�Ζ'(��

http://marketplace.eclipse.org/content/egit-git-team-provider
http://marketplace.eclipse.org/content/mercurialeclipse-was-hgeclipse#.Uk6qLIZcyWU
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Eclipse Color Theme
1RZ��D�FRPSOHWHO\�GL΍HUHQW�H[DPSOH�RI�D�JHQHULF�SOXJLQ�LV�WKH�Eclipse Color Theme��7KLV�PDNHV�WKH�FRORU�VFKHPH�RI�WKH�HGLWRUV�LQ�(FOLSVH�H[WUHPHO\�
FXVWRPL]DEOH�DQG�SURYLGHV�VHYHUDO�WKHPHV�WR�SLFN�IURP��ΖI�\RX�IDQF\�D�GDUN�FRORU�VFKHPH�WKHUH�DUH�VHYHUDO��SOXV�\RX�FDQ�LQVWDOO�WKLUG�SDUW\�WKHPHV 
IURP�WKH�LQWHUQHW��LQFOXGLQJ�VRODUL]HG���3LFN�RQH�WKDW�LV�WKH�HDVLHVW�RQ�\RXU�H\HV��

7KHUH�DUH�RWKHU�W\SHV�RI�SOXJLQV�WKDW�HQDEOH�VRPH�IXQFWLRQDOLW\�QRW�UHODWHG�WR�H[WHUQDO�WRROV��)RU�H[DPSOH��WKH�0RUH&OLSERDUG�SOXJLQ�DOORZV�\RX�WR� 
FXW�FRS\�SDVWH�XVLQJ�VHYHUDO�FOLSERDUGV�OLNH�YLP�EX΍HUV��2EYLRXVO\�WKHUH�DUH�KRWNH\V�WR�SHUIRUP�WKHVH�RSHUDWLRQV��

http://marketplace.eclipse.org/content/eclipse-color-theme#.UlK36WR81cQ
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JRebel for Eclipse

Disclaimer��:H�PDNH�-5HEHO��EXW�WKDW�GRHVQȇW�PDNH�LW�DQ\�OHVV�DZHVRPH��

Since productivity in Java development is extremely important, you can 
DPSOLI\�\RXU�SURMHFW�E\�LQVWDOOLQJ�WKLV�SOXJLQ�IURP�WKH�(FOLSVH�0DUNHWSODFH�
and eliminating the need to restart your application server each time you 
FKDQJH�FRGH��:LWK�WKH�Ȇ%XLOG�DXWRPDWLFDOO\ȇ�FKHFNER[�HQDEOHG��\RXȇOO�DOVR�
HQMR\�LQVWDQW�EXLOGV�DORQJ�ZLWK�QR�UHVWDUWVȃ-5HEHO�DOVR�PDLQWDLQV�VHVVLRQ�
VWDWH��VR�\RX�QHYHU�QHHG�WR�ȴQG�\RXU�SODFH�LQ�WKH�FRGH�DJDLQ�DIWHU�YHULI\LQJ�
WKDW�\RXU�FRGH�FKDQJHV�DUH�FRUUHFW�

CODE COMPLETION

If you're into Java, then you know that there's nothing more pleasant than 
HQMR\LQJ�VPDUW�FRQWHQW�DVVLVW�WKDW�OLWHUDOO\�FUHDWHV�WKH�SURJUDP�RQ�\RXU�
EHKDOI�ZKLOH�\RX�MXVW�FWUO�VSDFH��KRWNH\�IRU�FDOOLQJ�FRQWHQW�DVVLVW��OLNH�FUD]\�
 
Eclipse Code Recommenders takes assisting to the next level: it scans 
\RXU�FRGHEDVH�DQG�OHDUQV�IURP�LW�WR�R΍HU�RSHUDWLRQV�WKDW�DUH�FDOOHG�RQ�
VLPLODU�REMHFWV�LQ�VLPLODU�FRQGLWLRQV��<RX�GRQ
W�QHHG�WR�FRQVLGHU�D�KXQGUHG�
PHWKRGV�R΍HUHG�E\�D�SXEOLF�$3Ζ�WKDW�LV�QHYHU�XVHG��

Code Recommenders is intelligent and provides subword completion, so 
\RX�GRQ
W�QHHG�WR�JXHVV�WKH�SUHȴ[�RI�WKH�PHWKRG�QDPH��-XVW�VWDUW�W\SLQJ�DQ\�
SDUW�RI�LW�DQG�&RGH�5HFRPPHQGHUV�ZLOO�ȴJXUH�LW�RXW��

There's also a chain completion mode, so if some chain of methods is used 
RIWHQ��LW�ZLOO�R΍HU�LW�WR�\RX�DV�D�ZKROH�LQ�RQH�JR�

http://www.eclipse.org/recommenders/
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TESTING
Anyone adept at TDD would desire useful plugins to speed up your 
IHHGEDFN�F\FOH�HYHQ�PRUH��:H�UHFRPPHQG�JUnitLoop and ΖQȴQL7HVW, which 
ERWK�PRQLWRU�FKDQJHV�LQ�\RXU�SURMHFW�DQG�H[HFXWH�XQLW�WHVWV�IRU�DUHDV�WKDW�
FRXOG�EH�SRVVLEO\�D΍HFWHG��7KLV�PHDQV�WKDW�DIWHU�HYHU\�FKDQJH�\RX
OO�NQRZ�
LI�VRPHWKLQJ�LV�EURNHQ��$QG�ZH�WKLQN�WKDW�PRUH�ȊFUHDWH�WHVW��UHG�EDU��FRGH��
JUHHQ�EDUȋ�F\FOHV�LV�DOZD\V�D�JRRG�WKLQJ��

To help you utilize tests even more, check out additional code coverage 
SOXJLQV��)RU�H[DPSOH��EclEmma will help you with visualizing code coverage 
GDWD�ZLWK�WKRURXJK�UHSRUWV�DQG�V\QWD[�KLJKOLJKWLQJ��6R�HYHU\�WLPH�DIWHU�
running tests you will instantly see which code paths has or has not  
EHHQ�WHVWHG�

WORKSPACE MECHANIC
$�ȆZRUNVSDFHȇ�LV�D�UHDOO\�QLFH�SURMHFW�VHSDUDWLRQ�FRQFHSW��LW�NHHSV�DOO�UHODWHG�
SURMHFWV�WRJHWKHU�LQ�RQH�SODFH��PD\EH�DORQJ�ZLWK�VRPH�VPDOO�RU�WKURZDZD\�
SURMHFWV��EXW�OHWV�\RX�VHSDUDWH�LW�ZLWK�GL΍HUHQW�VHWXSV�

ΖWȇV�JUHDW�WKDW�\RX�KDYH�WRWDO�FRQWURO�RI�KRZ�\RXU�Ζ'(�WUHDWV�\RXU�SURMHFWV��
EXW�(FOLSVH�NHHSV�WKH�FRQȴJXUDWLRQ�VSHFLȴF�WR�WKH�ZRUNVSDFH���ZKLFK�LV�
often a pain to recreate over and over again in each and every workspace 
\RX�KDYH�

Workspace mechanic to the rescue! It allows you to create consistently set 
ZRUNVSDFHV�RU�VKDUH�\RXU�FRQȴJXUDWLRQ�ZLWK�D�WHDP�HDVLO\��

This plugins works by externalizing your settings and creating automated 
WDVNV�WR�ZDUQ�\RX�LI�WKH\ȇUH�QRW�FRPSOLDQW��ΖW�PDNHV�FRQȴJXULQJ�(FOLSVH�
PXFK�TXLFNHU�DQG�\RX�ZRQȇW�IRUJHW�WR�VHW�DQ\�VHWWLQJV�DJDLQ��

http://www.junitloop.org/index.php/JUnitLoop
http://infinitest.github.io/
http://www.eclemma.org/
https://code.google.com/a/eclipselabs.org/p/workspacemechanic/
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More advanced: How to write an Eclipse plugin

What if these existing plugins don’t cut it? You could of course write 
\RXU�RZQ��7KH�(FOLSVH�6WDQGDUG�EXQGOH�LQFOXGHV�DOO�\RX�QHHG�IRU�SOXJLQ�
GHYHORSPHQW��LQFOXGLQJ�WKH�3OXJLQ�'HYHORSPHQW�(QYLURQPHQW��3'(��DQG�WKH�
(FOLSVH�6'.��FRQWDLQLQJ�WKH�VRXUFH�FRGH�IRU�WKH�SODWIRUP�

If you start from something other than the Eclipse Standard package, 
\RX�FDQ�JHW�WKH�6'.V�IURP�WKH�XSGDWH�VLWH�QDPHG�Ȋ7KH�(FOLSVH�3URMHFW�
8SGDWHVȋ��IRU�(FOLSVH�����WKLV�LV�DW�http://download.eclipse.org/eclipse/
updates/4.3���E\�LQVWDOOLQJ�DW�OHDVW�(FOLSVH�6'.�DQG�(FOLSVH�3ODWIRUP�6'.�

Eclipse is perhaps the best IDE to write plugins for because the API has 
been very stable over the years--plugins written for old versions can still 
ZRUN�ZLWK�WKH�ODWHVW�YHUVLRQ�RI�(FOLSVH��(FOLSVH�LWVHOI�LV�FRPSOHWHO\�PDGH�RI�
SOXJLQV��26*L�EXQGOHV��VR�DGGLQJ�QHZ�SOXJLQV�LV�YHU\�QDWXUDO��7KHUH�DUH�ORWV�
of “Extension Points” that let you hook into the IDE functionality, making it 
SRVVLEOH�WR�FUHDWH�\RXU�RZQ�SHUVSHFWLYHV��YLHZV�DQG�HGLWRUV�

To create a plugin, select New -> Plug-in Project.�ΖQ�WKH�ȴUVW�ZL]DUG�SDJH��
MXVW�HQWHU�D�QDPH��VXFK�DV�+HOOR3OXJLQ��DQG�FOLFN�1H[W�XQWLO�\RX�VHH�D�OLVW�RI�
WHPSODWHV��6HOHFW�Ȋ+HOOR��:RUOG�&RPPDQGȋ��RU�DQRWKHU�WHPSODWH�LI�\RX�ZDQW��

http://download.eclipse.org/eclipse/downloads/
http://download.eclipse.org/eclipse/downloads/
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Click Finish�DQG�DFFHSW�WR�FKDQJH�WR�WKH�3'(�SHUVSHFWLYH�RU�QRW��7KH�3'(�
perspective doesn’t add much--only the Plugins View, which shows all the 
SOXJLQV�LQ�\RXU�Ȋ7DUJHW�3ODWIRUPȋ��7DUJHW�3ODWIRUP�LV�WKH�UXQQLQJ�(FOLSVH�
LQVWDQFH�E\�GHIDXOW��EXW�\RX�FDQ�DOVR�GHYHORS�DJDLQVW�D�GL΍HUHQW�YHUVLRQ� 
RI�(FOLSVH��

Observe what was created from the template:

META-INF/MANIFEST.MF�LV�ZKDW�GHȴQHV�\RXU�SOXJLQȇV�26*L�
PHWDGDWD��LQFOXGLQJ�GHSHQGHQFLHV�RQ�RWKHU�SOXJLQV��%\�GHIDXOW�LW�
should depend on org.eclipse.ui and org.eclipse.core.runtime�

plugin.xml�GHȴQHV�WKH�H[WHQVLRQV�WKDW�\RXU�SOXJLQ�SURYLGHV�� 
1RWH�WKDW�ERWK�RI�WKHVH�ȴOHV�DUH�RSHQHG�ZLWK�WKH�VDPH�*8Ζ�HGLWRU�
E\�GHIDXOW��EXW�WKHLU�GDWD�LV�LQ�GL΍HUHQW�WDEV��ΖQ�WKH�Extensions tab 
you can see that the plugin adds commands, handlers, bindings 
DQG�PHQXV��7R�VHH�PRUH�LQIRUPDWLRQ�DERXW�H[WHQVLRQV�LQ�WKLV�
HGLWRU��\RX�VKRXOG�KDYH�WKH�(FOLSVH�6'.�LQVWDOOHG�

Another note: the handler extension point has a “class” attribute 
WKDW�FRQWDLQV�WKH�TXDOLȴHG�QDPH�RI�D�KDQGOHU�FODVV��7KLV�LV�WKH�
usual mechanism how code is associated with extensions--
Eclipse will expect the class to have a default constructor and will 
LQVWDQWLDWH�LW�E\�FDOOLQJ�WKDW��7KLV�VDPSOH�KDQGOHU�FODVV�MXVW�RSHQV� 
D�PHVVDJH�GLDORJ�
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To see how the plugin works, you can open the Overview�SDJH�RI�WKH�SOXJLQ�HGLWRU��2Q�WKH�ULJKW�VLGH�\RX�FDQ�VHH� 
a Testing�VHFWLRQ��ZLWK�D�OLQN�Ȋ/DXQFK�DQ�(FOLSVH�DSSOLFDWLRQȋ��7KLV�ZLOO�ODXQFK�D�QHZ�LQVWDQFH�RI�\RXU�FXUUHQW�WDUJHW�
SODWIRUP�ZLWK�\RXU�SOXJLQ�LQVWDOOHG�DV�ZHOO��7KH�QHZ�(FOLSVH�LQVWDQFH�ZLOO�ODXQFK�ZLWK�D�QHZ�ZRUNVSDFH��EXW�\RX�FDQ�ODWHU�
open the 5XQ�&RQȴJXUDWLRQV�GLDORJ�DQG�FKDQJH�WKH�ZRUNVSDFH�RU�RWKHU�SURSHUWLHV�RI�WKH�(FOLSVH�DSSOLFDWLRQ�ODXQFK�

Once launched, you can see the plugin has added a “Sample Menu” to the menu bar, a command to the menu,  
DQG�D�NH\�ELQGLQJ��&WUO����WR�ODXQFK�WKH�FRPPDQG��7KLV�LV�SHUKDSV�WKH�VLPSOHVW�SOXJLQ�\RX�FRXOG�FUHDWH��EXW�WR�VHH�ZKDW�
HOVH�LV�SRVVLEOH��FKHFN�RXW�VRPH�RI�WKH�RWKHU�SOXJLQ�WHPSODWHV��<RX�FDQ�DOVR�VHH�VHSDUDWH�([WHQVLRQ�WHPSODWHV�WKDW�\RX�
can add to the plugin by clicking Add…�LQ�WKH�([WHQVLRQV�WDE�DQG�VHOHFWLQJ�([WHQVLRQ�:L]DUGV�

1RW�DOO�RI�WKH�IXQFWLRQDOLW\�\RX�FDQ�DGG�WR�(FOLSVH�QHFHVVDULO\�JRHV�WKURXJK�H[WHQVLRQV�LQ�SOXJLQ�[PO��6RPHWLPHV�\RX�FDQ�
DOVR�GR�WKLQJV�SURJUDPPDWLFDOO\��ΖI�\RX�NQRZ�ZKDW�\RX�ZDQW�WR�DGG��EXW�GRQȇW�NQRZ�ZKLFK�H[WHQVLRQV�RU�$3ΖV�DOORZ�\RX� 
WR�GR�LW��WKH�XVXDO�FKDQQHOV��*RRJOH��6WDFN2YHUȵRZ�HWF���VKRXOG�SURYLGH�KHOS��DQG�7KH�(FOLSVH�)RXQGDWLRQ�KDV�FROOHFWHG�
some articles at KWWS���ZZZ�HFOLSVH�RUJ�UHVRXUFHV��

http://www.eclipse.org/resources/
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A note about top Eclipse Marketplace plugins

If you look into the top plugins in the marketplace, you’ll see a somewhat 
XQUHSUHVHQWDWLYH�SLFWXUH�DFWXDOO\��7KH�WRS�VSRWV�DUH�RFFXSLHG�E\�6XEYHUVLRQ�
DQG�0DYHQ�LQWHJUDWLRQ�SOXJLQV��(VVHQWLDOO\��ZH�VHH�QRWKLQJ�ZURQJ�ZLWK�WKDW��
but lots of more interesting plugins are hiding out lower in the ranks, even 
LQ�WKH�7RS�����$V�RI�2FWREHU����������KHUH�LV�D�TXLFN�VQDSVKRW�RI�WKH�WRS����
DOO�WLPH�SOXJLQV�GRZQORDGHG�IURP�WKH�(FOLSVH�0DUNHWSODFH�

For example, the Mylyn plugin can help you manage tasks in your task 
tracker and it has several connectors that integrate with Github, Jira, 
)RJ%XJ]��%XJ=LOOD��HWF��:H�NQRZ�WKDW�\RX�FDQ�MXVW�DV�HDVLO\�DOW�7DE�WR�WKH�
browser window to manage your tasks, but the plugin is really useful 
to track the time that went into development, mention tasks in commit 
PHVVDJHV�DQG�LQȵXHQFHV�\RXU�OLIH�LQ�RWKHU�PLQRU��EXW�SRVLWLYH�ZD\V��

http://marketplace.eclipse.org/content/github-mylyn-connector/metrics#.Uk6zfIZcyWV
http://marketplace.eclipse.org/content/atlassian-connector-eclipse/metrics#.Uk6zjoZcyWV
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Eclipse integration with Application Servers and Build Tools

As Eclipse itself is an open platform for building basically anything you 
can imagine on top of it, it also contains a lot of integrations to application 
VHUYHUV��EXLOG�WRROV�DQG�RWKHU�VHUYLFHV�RU�SODWIRUPV��ΖW�PDNHV�VHQVH�WR�
TXLFNO\�UHYLHZ�WKHVH�DV�ZHOO�

APPLICATION SERVERS
:H�GLG�D�OLVW�RI�FRPPRQ�DSSOLFDWLRQ�VHUYHUV�DQG�WULHG�WR�ȴQG�DQ�DGDSWHU�IRU�
WKHP��7R�WHVW�LI�WKH�LQWHJUDWLRQ�ZRUNV�RXW�RI�WKH�ER[��ZH�LQVWDOOHG�WKH�ODWHVW�
(FOLSVH�.HSOHU�DQG�LPSRUWHG�D�SURMHFW�FDOOHG�ȊPetclinic”, which is a Spring-
EDVHG�VKRZFDVH�DSSOLFDWLRQ�SURYLGHG�E\�6SULQJ6RXUFH��:H�FRQVLGHU�LW�DV�
D�W\SLFDO��LI�VLPSOH��ZHE�DSSOLFDWLRQ��7KHUH�DUH�WZR�WDVNV�WKDW�ZH�H[SHFW�WR�
work for each app server adapter:

1.�$XWRPDWLF�GHSOR\PHQW�	�SXEOLVKLQJ�WR�WKH�$SS�6HUYHU�
2.�$ELOLW\�WR�VWDUW�DQG�VWRS�WKH�VHUYHU�IURP�(FOLSVH�

By default, Eclipse for Java EE developers comes with some bundled 
DSSOLFDWLRQ�VHUYHU�DGDSWHUV�IRU�$SDFKH�7RPFDW��PRVWO\�XS�WR�GDWH���-%RVV�
�RXWGDWHG��DQG�2EMHFW:HE�

Fortunately, it is quite easy to add additional app server adapters plus the 
links to the place where it should be:

https://github.com/zeroturnaround/petclinic
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Apache Tomcat

As we said, Eclipse for Java EE already comes with integration adapters for 
$SDFKH�7RPFDW��ZKLFK�ZRUNV�UHDOO\�ZHOO�WRR��7KH�7RPFDW�SOXJLQ�LV�DOZD\V�XS�
WR�GDWH�DQG�DOO�ODWHVW�YHUVLRQV�DUH�DYDLODEOH�LQ�WKH�SOXJLQ�

JBoss AS (aka WildFly)

ΖQWHJUDWLRQ�IRU�-%RVV�LV�DYDLODEOH�DQG�LW�LV�FDOOHG�Ȋ-%RVV�$6�7RROVȋ��$IWHU�
LQVWDOOLQJ�-%RVV�$6�����3HWFOLQLF�ZRUNHG�DOPRVW�RXW�RI�WKH�ER[��$OWKRXJK�WKH�
context path was wrongin the initially opened browser window, but it wasn't 
D�ELJ�GHDO��ΖQ�JHQHUDO���LQWHJUDWLRQ�ZLWK�-%RVV�$6�ORRNV�JRRG�

Jetty

-HWW\ȇV�LQWHJUDWLRQ�ZLWK�(FOLSVH�VHHPV�WR�EH�RXWGDWHG��$OWKRXJK�WKHUH� 
is already Jetty v9 out, the latest Jetty version from the Jetty adapter we 
ZHUH�DEOH�WR�ȴQG�LQIR�DERXW�ZDV�Y���$QG�WKH�ROG�SOXJLQ�ZDV�UHOHDVHG�E\�
0RUWED\�ΖQF�

Oracle GlassFish Server

Oracle provides server tools for GlassFish, which are available in the list of 
DYDLODEOH�VHUYHU�DGDSWHUV��2UDFOH�*ODVVȴVK���ZRUNV�SUHWW\�ZHOO�ZLWK�(FOLSVH��
ZH�KDG�QR�KDVVOHV�ZKHQ�ZH�LQVWDOOHG�LW��DQG�HYHU\WKLQJ�ZRUNHG�MXVW�ȴQH��
Well done, GlassFish team!

Oracle WebLogic Server

We had some problems getting Petclinic + Eclipse + WebLogic working out 
RI�WKH�ER[��3XEOLVKLQJ�IURP�(FOLSVH�GLG�QRW�ZRUN�SURSHUO\��VRPH�OLEUDULHV�
GLGQ
W�JHW�SXEOLVKHG�DQG�WKH�DSSOLFDWLRQ�GLG�QRW�ZRUN�SURSHUO\�

Ζ%0�/LEHUW\�3URȴOH
(YHQ�WKRXJK�WKHUH�LV�QR�/LEHUW\�3URȴOH�SOXJLQ�IRU�WKH�ODWHVW�YHUVLRQ�RI�(FOLSVH�
�.HSOHU���WKH�SOXJLQ�PHDQW�IRU�(FOLSVH�-XQR�ZRUNHG�SUHWW\�ZHOO��DQG�ZH�GLG�
QRW�HQFRXQWHU�DQ\�SUREOHPV��(YHU\WKLQJ�ZRUNHG��:HE6SKHUH�ZDV�XS�DQG�
UXQQLQJ��DQG�(FOLSVH�ZDV�DEOH�WR�GHSOR\�DSSV�RQ�LW�
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INTEGRATION WITH JAVA BUILD TOOLS
'HYHORSPHQW�HQYLURQPHQWV�DUH�QRW�MXVW�SODLQ�Ζ'(V�WKDW�PDQDJH�IROGHUV�IXOO�
RI�VRXUFH�FRGHV��7KHUH�DUH�VRPH�RWKHU�FRPSOLFDWHG�WRROV�DURXQG�OLNH�EXLOG�
WRROV��GHSHQGHQF\�PDQDJHPHQW�WRROV�DQG�VKHOO�VFULSWV��:H�DUH�JRLQJ�WR�
take a look at some most common tools here and see how Eclipse works 
ZLWK�WKHP�

Maven

Maven integration for Eclipse is mostly based on the m2e plugin��http://
HFOLSVH�RUJ�P�H����7KH�SOXJLQ�LV�QRZ�XQGHU�WKH�XPEUHOOD�RI�WKH�(FOLSVH�
)RXQGDWLRQ�LWVHOI��ZKLFK�LV�SUREDEO\�JRRG�IRU�WKH�SOXJLQ�LQ�WKH�ORQJ�WHUP�

Ant + Ivy

$QW�VXSSRUW�IRU�(FOLSVH�FRPHV�RXW�RI�WKH�ER[�DQG�LW�ZRUNV�SUHWW\�ZHOO��ΖY\'(�
HQDEOHV�\RX�WR�LQWHJUDWH�ΖY\ȇV�GHSHQGHQF\�PDQDJHPHQW�LQWR�(FOLSVH�� 
ΖW�VHHPV�WR�EH�ZHOO�ZRUNLQJ�DQG�XQGHU�DFWLYH�GHYHORSPHQW���PDLQWHQDQFH�

Gradle

Gradle support for Eclipse is excellent, with one of the best-documented 
LQWHJUDWLRQV�RXW�WKHUH��<RX�FDQ�PLJUDWH�H[LVWLQJ�SURMHFWV�LQWR�(FOLSVH�SURMHFWV�
DQG�\RX�FDQ�DOVR�H[HFXWUH�*UDGOH�IURP�ZLWKLQ�(FOLSVH��-XVW�UXQ�ȊJUDGOH�HFOLSVHȋ�
IURP�WKH�FRPPDQG�OLQH�DQG�DOO�FODVVSDWK�	�Ζ'(�VSHFLȴF�FRQȴJXUDWLRQ�LVVXHV�
DUH�VROYHG��6R��LI�\RX�FDUH�D�ORW�DERXW�KDYLQJ�D�ZHOO�GRFXPHQWHG�WRROLQJ�DQG�
SURMHFW�VHWXS��WKHQ�(FOLSVH�	�*UDGOH�PD\�EH�D�JRRG�ZD\�WR�JR�KHUH�

http://eclipse.org/m2e/
http://eclipse.org/m2e/
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PART III:  
TIPS AND TRICKS FOR USING  
ECLIPSE LIKE A SUPER-NINJA BAD@$$

Now that your Eclipse installation has all the best 
SOXJLQV�LQVWDOOHG��DQG�\RXȇYH�FRQȴJXUHG�LQWHJUDWLRQV�
with the external software you use, it’s time to be 
awesome. While some may consider your IDE more 
or less an advanced notepad, there are some tips 
we would like to share to make your experience 
more pleasant. 
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Navigating your Eclipse installation

QUICK ACCESS
'R�\RX�NQRZ�ZK\�YLP�LV�VWLOO�SRSXODU����\HDUV�
after its initial release? Because it enables 
excellent text navigation capabilities, which 
LV�WKH�NH\�WR�EHLQJ�SURGXFWLYH�ZLWK�\RXU�Ζ'(�
 
(FOLSVH�R΍HUV�\RX�WKH�VDPH�QDYLJDWLRQDO�
supremacy, but with a much more intuitive 
LQWHUIDFH��1DYLJDWLRQ�LQ�(FOLSVH�LV�EDVHG�
on shortcuts and key-bindings, with the
most important being a quick access 
shortcut (Ctrl+3)�

Start typing what you have in mind and see 
Eclipse search in available views, menus, 
SRVVLEOH�DFWLRQ�LWHPV��FRQȴJXUDWLRQ��
everything! Look what happens when we 
VLPSO\�W\SH�ȊIȋ�

'RQȇW�JR�WKURXJK�PHQXV�WR�ȴQG�WKDW�REVFXUH�
VHWWLQJ�WKDW�\RX�QHHG�WR�WRJJOH��MXPS�ULJKW�
WR�LW�DQG�JHW�LW�GRQH��)RU�H[DPSOH��ZKHQ�\RX�
ZDQW�WR�FUHDWH�QHZ�ȴOH�\RX�FDQ�XVH�Ctrl+N 
combination, or instead of remembering all 
the shortcuts that you rarely use, try Ctrl+3 
!�ȊQHZ�ȴOHȋ��$QG�ZKLOH�LW�LV�MXVW�D�WLQ\�ELW�
longer, you have quick access to amazing 
SRZHU�ULJKW�WKHUH�
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FILE NAVIGATION
1RZ�\RX�FDQ�QDYLJDWH�(FOLSVH�OLNH�D�QLQMD�� 
EXW�ZKDW�DERXW�QDYLJDWLQJ�ȴOHV"�Open Type 
and Open Resource�DUH�\RXU�IULHQGV��

Open Type (Ctrl+Shift+T) shows you a dialog 
where you can the type name of the class to 
RSHQ��DND�&DPHO&DVH�PDWFKLQJ�VHDUFK���1RWH�
that you can go with capital letters from class 
QDPH�RQO\��

Open Resource (Ctrl+Shift+R) which 
operates in the same way but also includes 
QRQ�FODVV�ȴOHV��/RRNLQJ�IRU�D�FHUWDLQ�pom.xml 

LV�GRQH�LQ�D�VHFRQG�
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CLASS OUTLINE
Finally, when in a class you can use the  
usual incremental search--Ctrl+F--like any 
other editor provides, or you can be more 
fancy and use class outline (Ctrl+O), to 
TXLFNO\�JHW�WR�D�GHȴQLWLRQ�RI�D�FODVV�PHPEHU��
VXFK�DV�D�PHWKRG�RU�ȴHOG��3UHVV�Ctrl+O again 
DQG�\RX�FDQ�VHOHFW�DQG�MXPS�WR�LQKHULWHG�
PHWKRGV�GHFODUDWLRQV��

Finally, there is a go to line DFWLRQ��Ctrl+L), 
ZKLFK�FDQ�VDYH�\RX�VRPH�VFUROOLQJ��
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STACK TRACE CONSOLE

The last tip to share about navigation is to make use of the stack trace console��ΖPDJLQH�\RX�JRW�DQ�H[FHSWLRQ�VWDFN�WUDFH� 
IURP�VRPHZKHUH�OLNH�\RXU�VXSSRUW�HPDLO��FRQVROH�ORJV�RU�\RXU�&Ζ�VHUYHU��&RS\�LW�WR�\RXU�V\VWHP�FOLSERDUG�
 
In Eclipse, use Ctrl+3�WR�W\SH�ȊFOLSERDUGȋ�DQG�VHOHFW�Ȋ2SHQ�IURP�FOLSERDUGȋ���1RZ�MXVW�FOLFN�RQ�KLJKOLJKWHG�OLQNV�WR�TXLFNO\� 
JR�WR�WKH�OLQH�IURP�WKH�VWDFN�WUDFH�

7KLV�LV�D�VXEWOH�SURGXFWLYLW\�LPSURYHPHQW��EXW�VRPHWLPHV�LWȇV�YHU\�XVHIXO�WR�WUDYHUVH�DQ�H[FHSWLRQ�WUDFH�

If you’d like to embed your navigation habits deep into motoric memory, you can use IDE++ plugin��ΖW�ZLOO�OHDUQ�RI�\RXU�XVH�RI� 
WKH�(FOLSVH�DQG�VRPHWLPHV�VKRZ�\RX�D�SRSXS�DERXW�KRZ�\RX�FDQ�PDNH�FHUWDLQ�WKLQJV�KDSSHQ�IDVWHU��ΖQ�WKHRU\�WKLV�LV�DZHVRPH��
but  the experience of some of our developers has shown us that this can get annoying, and after a while you’ll be tempted to 
MXVW�SLFN�D�WLS�RU�WZR��OLNH�JRLQJ�WR�WKH�SODFH�RI�\RXU�ODVW�HGLW�RSHUDWLRQ�ZLWK�Ctrl+Q��DQG�WKHQ�XQLQVWDOO�LW��

http://marketplace.eclipse.org/content/ide#.Uk66noZcyWU
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MAKING ECLIPSE  
A BIT MORE CLEVER
By this point, you should already be quite 
SURGXFWLYH�ZLWK�(FOLSVH��+RZHYHU�WKHUH�DUH�
some settings to tweak to make Eclipse 
VPDUWHU�DQG�OHVV�LUULWDWLQJ��

First of all, when we get a fresh copy of 
(FOLSVH�WR�FRQȴJXUH��LWȇV�VPDUW�WR�JR�RYHU�LWV�
SUHIHUHQFHV�DQG�PDNH�LW�ZRUN�MXVW�OLNH�DQ\�
RWKHU�(FOLSVH�LQVWDOODWLRQ�\RXȇYH�XVHG�EHIRUH��
Muscle memory is super fast and convenient 
way to leave your brain's cycles  
IRU�SURJUDPPLQJ�

Typing is the one of the main activities,  
so be sure to make Eclipse automatically 
insert matching elements for all kinds of 
GRXEOH�HOHPHQWV��Ȋ��^��>��������<RX�FDQ�DOVR�
make it possible to insert semicolons to the 
FRUUHFW�SRVLWLRQ�PDJLFDOO\��ΖW�UHDOO\�KHOSV�
\RX�W\SH�IDVWHU�ZKHQ�\RX�FDQ�ȴQLVK�DQ\�
expression with semicolon-enter from any 
SRVLWLRQ�LQVLGH�RI�H[SUHVVLRQ�
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$IWHU�\RXȇYH�FRQȴJXUHG�WKH�W\SLQJ�
preferences according to your taste, another 
FKDQJH�ZH�SUHIHU�WR�PDNH�LQ�(FOLSVH�LV�WR�ȴ[�
XS�FRQWHQW�DVVLVW��6RPHWLPHV��FRQWHQW�DVVLVW�
ȴQLVKHV�D�PHWKRG�FDOO�IRU�\RX��EXW�LQVWHDG�
of guessing which variables were meant 
to become arguments, it does something 
XQLQWHOOLJHQW��ΖQ�IDFW��\RX�FDQ�FRQȴJXUH�
(FOLSVH�WR�JXHVV�WKH�SDUDPHWHUV��

&KHFN�RXW�WKH�GL΍HUHQFH�RQ�WKH�LPDJHV�
EHORZ��2Q�WKH�OHIW��\RX�FDQ�VHH�ȊΖQVHUW�
parameter names” and on the right are best 
JXHVVHG�DUJXPHQWV��ΖQ�RXU�H[SHULHQFH��WKH�
EHVW�JXHVVHG�DUJXPHQWV�ZLQ�LQ���Y��
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$QRWKHU�FRRO�FRQȴJXUDWLRQ�WLS�LV�WR�PDNH�XVH�
RI�Ȋ7\SH�)LOWHUVȋ��%DVLFDOO\��\RX�FDQ�WHOO�(FOLSVH�
that there are certain packages that you don’t 
ZDQW�WR�GHDO�ZLWK��<HDK��java.awt.*, we’re 
looking at you! 

<RX�FDQ�ȴQG�7\SH�)LOWHUV�FRQȴJXUDWLRQ�
under: Preferences > Java > Appearance 
!�7\SH�)LOWHUV�RU�&WUO����!�W\SH�ȴOWHUV��
Packages added there will be removed from 
content assist pop-ups and automatic import 
RUJDQL]DWLRQ��

Now you can safely type List list = new 
ArrayList(); and not be frustrated by 
LUUHOHYDQW�LPSRUW�RSWLRQV��
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SAVE ACTIONS

Another useful feature in Eclipse are Save Actions��$�VDYH�DFWLRQ�LV�
VRPHWKLQJ�WKDW�LV�DXWRPDWLFDOO\�UXQ�RQ�D�ȴOH�ZKHQ�LW�LV�VDYHG��ZKLFK�FDQ�EH�
TXLWH�XVHIXO�DQG�SURGXFWLYH��

. Format code�LQ�D�QHZHU�SURMHFW�JR�IRU�IRUPDWWLQJ�DOO�OLQHV�LQ�
� D�VDYHG�ȴOH��ZKHQ�GHDOLQJ�ZLWK�D�ODUJHU��SDUWLDOO\�QRQ�IRUPDWWHG��
� FRGHEDVH��IRUPDW�HGLWHG�OLQHV�RQO\��

. Organize imports - this allows you to skip importing classes, 
� VR�\RX�FDQ�MXVW�VDYH�\RXU�VRXUFH�ȴOH�DQG�HQMR\�WKH�EHQHȴWV�
� RI�DXWRPDWLRQ��

. Don’t remove unused code - we won’t suggest to remove 
� XQXVHG�FRGH�IURP�VRXUFH�ȴOHV��EHFDXVH�LW�ZLOO�DQQR\�\RX�IURP�
� WLPH�WR�WLPH�

6R�IDU��ZH�KDYH�D�GHFHQW�EDVLF�VHW�RI�FRQȴJXUDWLRQ�RSWLRQV�WKDW�\RX�FDQ�
HPSOR\�WR�PDNH�\RXU�OLIH�LQ�(FOLSVH�PRUH�SURGXFWLYH��:HȇUH�VXUH�WKDW�\RX�
can tell us about many more hidden options that make things better, but 
for now let’s look at a few good shortcuts to know, like:

1.�&WUO�������ȴ[�SUREOHP��RSHQ�VXJJHVWLRQ�ER[

2. Alt + Shift + L - extract a local variable

3. Alt + Shift + I - inline a variable

4. Alt + Shift + M - extract a method

5. Alt + Shift + R - rename

6. Alt + left arrow - select an expression

0DVWHUIXO�XVH�RI�WKRVH�ZLOO�LPSURYH�WKH�VSHHG�RI�GHYHORSPHQW�E\�D�ORW��
Happy hacking!
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USE YOUR DEBUGGER LIKE A NINJA

Just like anything else, it’s good to learn to 
XVH�WKH�-DYD�GHEXJJHU�LQ�(FOLSVH�HɝFLHQWO\��
Firstly, you should open the debug 
perspective and customize it--by default it 
has some irrelevant views open and instead 
hides some rather important ones! Here 
LV�ZKDW�LW�PLJKW�ORRN�OLNH�LQ�WKH�(FOLSVH�����
Kepler Java EE package:
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Remember, you always have Quick Outline 
DYDLODEOH��&WUO�2��LI�\RX�QHHG�LW��VR�ZK\�ZDVWH�
screen space for a permanent Outline view? 
We recommend you also close the Servers 
and Tasks�YLHZV��7KHQ�\RX�FDQ�GUDJ�Variables 
where Outline used to be, so you can view 
variables and have access to breakpoints 
DW�WKH�VDPH�WLPH��DQG�RSHQ��&WUO�����YLHZ�
name>) Expressions and Display�YLHZV�

The Display view is perhaps one of the most 
important ones in Eclipse, since it lets you 
type code and evaluate it in the context of 
WKH�FXUUHQW�GHEXJ�VHVVLRQ��7KLV�LV�YHU\�XVHIXO�
when dealing with badly documented code 
ZLWK�ZKLFK�\RX�KDYH�WR�LQWHJUDWH��RU�MXVW�
discovering APIs and seeing what they return 
DW�UXQWLPH�
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Next, you may want to switch the Variables�YLHZ�WR�VKRZ�ORJLFDO�VWUXFWXUH��
This hides the implementation details of classes like HashMap, and instead 
VKRZV�\RX�MXVW�WKH�NH\V�DQG�YDOXHV�

You may also want to check out the Preference page Java > Debug and 
play with settings for detail formatters, which can make it even easier to see 
WKH�VWUXFWXUH�RI�FROOHFWLRQV�

One of the coolest things that you can do with the debugger is change what 
KDV�DOUHDG\�KDSSHQHG�DQG�WHVW�RXW�SRWHQWLDO�ȴ[HV�WR�FRGH�DW�UXQWLPH��)RU�
example, this next example has a method that returns a list full of integers 
XS�WR�WKH�QXPEHU�JLYHQ�LQ�D�SDUDPHWHU��7KLV�PHWKRG�LV�FDOOHG�ZLWK�QXPEHUV�
from 0 to 9, but we want to debug a case where the number is somewhat 
ELJJHU�WKDQ����OHWV�VD\����6R�ȴUVW��ZH�VHW�D�FRQGLWLRQDO�EUHDNSRLQW�E\�ULJKW�
clicking on the breakpoint and selecting Properties�

While the loop is already executing during debugging, you may discover that 
you wanted the numbers starting with 1 instead of 0, and the limit “i” should 
EH�LQFOXVLYH��VR�\RX�DUH�H[SHFWLQJ�D�OLVW�RI�>�������@�

7KH�VLPSOHVW�ZD\�WR�GR�WKLV�LQ�WKLV�FDVH�LV�WR�MXVW�ȴ[�WKH�FRGH��numbers.
add(j + 1)) and save -- Eclipse will use HotSwap to update the 
method body and automatically “Drop Frame” to start execution of the 
PHWKRG�RYHU�DJDLQ�
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Another way, without saving the change yet, is to let the for loop run its 
FRXUVH��WKHQ�FRS\�WKH�FRGH�WR�WKH�'LVSOD\�YLHZ��ȴ[�LW�WKHUH�DQG�H[HFXWH�LW�

<HW�DQRWKHU�ZD\�LV�WR�DOVR�OHW�WKH�ORRS�ȴQLVK��DQG�WKHQ�XVH�WKH�Variables view 
to change the value of each element in “numbers” manually:

%XW�LQ�WKLV�VLPSOH�FDVH��ZH�ZRXOGQȇW�ERWKHU�DQG�MXVW�XVH�WKH�ȴUVW�PHWKRG�
with HotSwap and Drop to Frame, but in complex cases you might 
QHHG�D�FRPELQDWLRQ�RI�WKHVH�DSSURDFKHV��OHWWLQJ�D�ȴ[HG�FRGH�UXQ�DJDLQ��
LPSOHPHQWLQJ�PRGLȴHG�FRGH�LQ�Display view to change a variable, or 
FKDQJLQJ�YDOXHV�RQH�E\�RQH�LQ�9DULDEOHV�YLHZ�

With the tools and methods above at your disposal, you should be able to 
VWDUW�XVLQJ�(FOLSVH�OLNH�D�QLQMD�IDLUO\�TXLFNO\��1H[W��ZH�VXPPDUL]H�ZKDWȇV�EHHQ�
said in this report, go over some of the things that Eclipse does that other 
IDEs don’t, and address of the common complaints by Eclipse users and 
VRPH�ZD\V�WR�ȴ[�WKHP��$QG�OHWȇV�QRW�IRUJHW��WKH�IDPRXV�;.&'�FRPLF�
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TL;DR:  
SUMMARY, CONCLUSION  
AND A GOODBYE COMIC ;-) 

It’s hard to see Eclipse IDE as a product alone--more than 
anything else, it’s a long-term project and developing 
platform that grows with its community. It’s a massive 
foundation from which many other tributaries to branch 
R΍��DQG�LWȇV�TXLWH�OLNHO\�WKDW�ZH�FRXOG�KDYH�DGGHG�DQRWKHU�
50 pages to this report as well. But all good things come  
to an end, and here is what we covered for you TL;DR 
lovers out there.
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Summary of previous sections

PART I: GETTING STARTED WITH INSTALLATION  
AND MAINTENANCE 

7KLV�VHFWLRQ�VWDUWHG�R΍�ZLWK�D�TXLFN�RYHUYLHZ�RI�WKH�(FOLSVH�EXQGOHV�IRU�-DYD�
EE, Java, C, C++ and Android, then went on to options for platform runtime 
ELQDULHV�DQG�D�ELW�RQ�26*L��ΖI�\RX�GLGQȇW�NQRZ��WKH�IROORZLQJ�Ζ'(V�KHUH�
are all based on Eclipse: MyEclipse, IBM RAD and JBoss Developer Studio 
IURP�5HG�+DW��ΖWȇV�SRVVLEOH�WR�PLJUDWH�WR�D�QHZ�YHUVLRQ�RI�(FOLSVH�ZLWKRXW�
ruining all your previous settings and preferences by installing via an 
existing installation, and we have some tips here for easily increasing your 
performance early on and minimizing defaults that we soon found to be 
DQQR\LQJ��)RU�6FDOD��3\WKRQ�DQG�;WHQG�SURJUDPPHUV��(FOLSVH�KDV�ODQJXDJH�
packs for you too!

PART II: MAKING ECLIPSE YOUR OWN

Getting Eclipse set up how you want is going to need some plugins and 
FXVWRPL]DWLRQV��ΖQ�WKLV�VHFWLRQ�ZH�LQWURGXFH�WKH�(FOLSVH�0DUNHWSODFH�
DQG�VRPH�SOXJLQV�ZH�WKLQN�WKDW�DQ\�-DYD�GHY�FDQ�HQMR\��OLNH�(*LW��
MercurialEclipse, Eclipse Color Theme, JRebel, Eclipse Code Recommenders, 
-8QLW/RRS��ΖQȴQL7HVW�DQG�:RUNVSDFH�0HFKDQLF��7KHQ��ZH�VKRZ�\RX�KRZ�WR�
JHW�VWDUWHG�R΍�RQ�WKH�URDG�WR�-DYD�VWDUGRP�E\�ZULWLQJ�\RXU�YHU\�RZQ�SOXJLQ�
IRU�WKH�(FOLSVH�0DUNHWSODFH��7KHQ�D�TXLFN�RYHUYLHZ�RI�(FOLSVHȇV�LQWHJUDWLRQV�
ZLWK�$SSOLFDWLRQ�6HUYHUV�OLNH�$SDFKH�7RPFDW��-%RVV�$6��:LOG)O\���-HWW\��
*ODVV)LVK��:HE/RJLF�DQG�:HE6SKHUH��/LEHUW\�3URȴOH��SOXV�%XLOG�7RROV�OLNH�
0DYHQ��$QW�ΖY\�DQG�*UDGOH�

PART III: TIPS AND TRICKS FOR USING ECLIPSE  
LIKE A SUPER-NINJA BAD@$$

)RU�\RX�VHDVRQHG�(FOLSVH�XVHUV��ZH�R΍HU�VRPH�QDYLJDWLRQDO�WULFNV�IRU�
LPSURYLQJ�ȴOH�QDYLJDWLRQ��FODVV�RXWOLQH��VWDFN�WUDFH�FRQVROH�DQG�RWKHUV��
<RX�FDQ�PDNH�\RXU�(FOLSVH�LQVWDOODWLRQ�PRUH�FOHYHU�ZLWK�FRQȴJXULQJ�W\SLQJ�
SUHIHUHQFHV��FRQWHQW�DVVLVW��W\SH�ȴOWHUV�DQG�VDYH�DFWLRQV��)LQDOO\��ZH�ȴQLVK�
R΍�ZLWK�VRPH�SUHWW\�FRRO�QLQMD�GHEXJJHU�DFWLRQV�WKDW�\RX�PLJKW�HQMR\�
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Concluding thoughts and a little humor
After reading this, you might think that Eclipse is the best thing since sliced 
EUHDG��:KLOH�ZH�OLNH�WR�EH�DEOH�WR�H[SUHVV�RXU�RSLQLRQV��HVSHFLDOO\�SRLQWLQJ�
RXW�WKH�WKLQJV�LQ�(FOLSVH�WKDW�ZH�GRQȇW�DOZD\V�HQMR\��LWȇV�QRW�RXU�LQWHQWLRQ�WR�
ZDVWH�\RXU�WLPH�ZLWK�FRPSODLQWV��7KLV�UHSRUW�LQWHQGV�WR�EH�D�VRXUFH�IRU�QHZ�
DQG�H[SHULHQFHG�XVHUV�DOLNH�WR�XVH�WKHLU�VHOHFWHG�WRRO�EHWWHU��WKDWȇV�DOO�

WHAT DEVS OFTEN SAY WHEN THEY COMPLAIN  
ABOUT ECLIPSE
As part of this conclusion, we should acknowledge some of the more 
common complaints we hear about Eclipse from users, and some brief 
VXJJHVWLRQV�IRU�LPSURYLQJ�XSRQ�WKHP�

“Eclipse is slow.”

ΖI�\RX�VWLOO�XVH�-XQR��SOHDVH�XSJUDGH�DVDS��2WKHU�WKDQ�WKDW��FRQȴJXULQJ�(FOLSVH�
WR�GR�OHVV�XQQHFHVVDU\�WKLQJV�KHOSV�D�ELW��3OD\LQJ�ZLWK�-90�DUJXPHQWV�DOVR�
gives it a boost, and uninstalling plugins that you don’t use or building your 
Ζ'(�IURP�5XQWLPH�%LQDULHV�LV�D�ZD\�WR�JHW�QRWLFHDEO\�EHWWHU�SHUIRUPDQFH�

“The UI is clumsy and I don’t like it.”

8WLOL]H�GL΍HUHQW�SHUVSHFWLYHV�DQG�FXVWRPLVH�WKHP�DV�\RX�ZRXOG�OLNH�� 
If you want to get the maximum working area, you can use Ctrl+M  
RQ�\RXU�FXUUHQWO\�RSHQ�HGLWRU��&KHFN�RXW�fullscreen plugin to enhance  
WKDW�H[SHULHQFH�

“Content assist and organise imports keep asking about awt and other 
irrelevant classes.”

8VH�W\SH�ȴOWHUV�WR�SUHYHQW�(FOLSVH�IURP�VXJJHVWLQJ�FODVVHV�WKDW�\RX�QHYHU�
XVH��Use Code Recommenders plugin to improve what content assist  
GRHV�IRU�\RX��

http://marketplace.eclipse.org/content/eclipse-fullscreen#.Uk7mMoZcyWU
http://www.eclipse.org/recommenders/
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SOME THINGS THAT ECLIPSE DOES THAT  
OTHER IDES DON’T DO
Not every IDE is created equally, and it’s worth more than half a groat to 
HVWLPDWH�WKH�ȵDPHZDU�SRWHQWLDO�WKDW�WKLV�FRQYHUVDWLRQ�EULQJV�DORQJ�ZLWK�LW��
But it turns out that Eclipse does a couple things that IntelliJ IDEA, NetBeans, 
DQG�RWKHU�Ζ'(V�GR�QRW��

For example, Eclipse is the only IDE that has it’s own compiler, and it’s 
SUHWW\�VPDUW�DERXW�FRGH�WKDW�FRQWDLQ�HUURUV��:KHQ�\RXU�FODVV�ȴOH�GRHVQȇW�
compile, Eclipse inserts an unresolved compilation error, like this one:

Exception in thread "main" java.lang.Error: Unresolved compilation 
problems: 
 Syntax error, insert "AssignmentOperator Expression" to  
 complete Assignment
 Syntax error, insert ";" to complete BlockStatements
 a cannot be resolved to a variable 

However, the class is compiled otherwise and is functional unless you’re 
UHDFKLQJ�IRU�WKH�PHWKRG�LQ�TXHVWLRQ�

This second one is questionable, since we aren’t 100% sure at the time 
of this writing if there isn’t some similar functionality hiding somewhere 
LQ�1HW%HDQV�RU�ΖQWHOOL-�Ζ'($��ZHȇOO�ȴQG�RXW����EXW�ZH�IHOW�LW�LPSRUWDQW�WR�
PHQWLRQ�(FOLSVHȇV�6FUDSERRN�IXQFWLRQDOLW\��6FUDSERRN�LV�D�UHJXODU�ȴOH��QRW�
UHODWHG�WR�DQ\�SURMHFWV�ZKLFK�FDQ�EH�XVHG�WR�LQVSHFW�DQG�HYDOXDWH�-DYD�FRGH�
H[SUHVVLRQV��7KH�FRRO�WKLQJ�LV�WKDW�ZLWK�6FUDSERRN��\RX�FDQ�SDVWH�SLHFHV�RI�
code there and quickly see what that code actually does--essentially, it lets 
you inspect, evaluate and debug, all in a separate window and away from 
WKH�ODUJHU�FRGH�EDVH��

Can emacs do that? ;-)
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KWWS���[NFG�FRP�����

http://xkcd.com/378/
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http://zeroturnaround.com/software/jrebel/trial/
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